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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:

THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION ("YOKOGAWA"). BY INSTALLING OR OTHERWISE USING THE
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE
THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE.

Software License Agreement

1. Scope

This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, "Software Product"). Unless otherwise provided by
Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa.

Software Product: DAQWORX (It is limited to each software that you bought).

2. Grant of License
2.1Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a
single or, the following specified number of, computer(s) and solely for your internal operation use, in consideration of full payment by you to Yokogawa of the license fee
separately agreed upon.
Granted number of License: 1 (one)
2.2Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:
a) toreproduce the Software Product, except for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;
b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any
other person or entity;
c) to use the Software Product on any unauthorized computer via the network;
d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other
human readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;
e) to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or
f)  to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.
2.3Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa.
Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder.
2.4You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other
than your employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations
hereunder.
2.5Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your
computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.
2.6The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa ("Third
Party Software"). If suppliers of the Third Party Software ("Supplier") provide special terms and conditions for the Third Party Software which differ from this Agreement,
the special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier.
2.7The Software Product may contain open source software ("OSS"), for which the special terms and conditions separately provided by Yokogawa shall take precedence
over this Agreement.

3. Restrictions on Application

3.1Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft
operation or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail
facility, nuclear related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2If the Software Product is used for the abovementioned purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use
and you shall indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage
whatsoever, including any court costs and attorney's fees, arising out of or related to the said use.

4. Limited Warranty

4.1The Software Product shall be provided to you on an “as is" basis at the time of delivery and except for physical damage to the recording medium containing the Software
Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom. If any physical defect is found on the
recording medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective medium
shall be returned to the service office designated by Yokogawa at your expense within the said twelve (12) months. THIS LIMITED WARRANTY PROVIDED IN THIS
CLAUSE IS IN LIEU OF ALL OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES RELATING
TO THE SOFTWARE PRODUCT, WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR ANY PARTICULAR PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY, RELIABILITY AND RECENCY.
IN NO EVENT SHALL YOKOGAWA WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE SOFTWARE PRODUCT AND OTHER
SOFTWARE NOR SHALL BE LIABLE THEREFOR. The warranty provisions of the applicable law are expressly excluded to the extent permitted.

4.2At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number ("Upgrade") and make it available to you at your expense
or free of charge as Yokogawa deems fit. In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3Certain maintenance service may be available for some types of Software Product at Yokogawa's current list price. Scope and terms and conditions of the maintenance
service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than
5 years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more
than 5 years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide
any service for the Software Product which has been modified or changed by any person other than Yokogawa.
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Software License Agreement

5. Infringement

5.1If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party's patent (which is issued at the time of delivery
of the Software Product), trade mark, copyright or other intellectual property rights ("Claim"), you shall promptly notify Yokogawa thereof in writing.

5.2If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa's expense and indemnify you from the damages finally granted by
the court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa of
the Claim in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you give
every and all necessary information and assistance to Yokogawa upon Yokogawa's request.

5.3If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the
Software Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it
become non-infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value
of the Software Product as depreciated.

5.4Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the
infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or
software not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa's suggestion, or e) any other causes not
attributable to Yokogawa.

5.5This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party's intellectual
property rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special
terms and conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability

6.1EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY
PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES,
OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT,
OR ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN
WARRANTY (EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS.
IN NO EVENT YOKOGAWA AND SUPPLIER'S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE
5) SHALL EXCEED THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE
PRODUCT. If the Software Product delivered by Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa catalogues,
General Specifications, basic specifications, functional specifications or manuals without Yokogawa's prior written consent, Yokogawa shall be exempted from its
obligations and liabilities under this Agreement or law.

6.2Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the
cause of action accrues.

7. Export Control

You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa.
If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America,
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense.

8. Audit; Withholding

8.1Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product
as may be reasonably necessary in Yokogawa's opinion to verify that the requirements of this Agreement are being met.

8.2Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery
and, in Yokogawa's reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to
continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment

If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this
Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession
irretrievably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination

Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of
this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product,
certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any
termination of this Agreement.

11. Governing Law; Disputes

This Agreement shall be governed by and construed in accordance with the laws of Japan.

Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement ("Dispute") shall be resolved
amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either
party to the other, the Dispute shall be addressed in the following manner:

(i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.

(i) If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules
of the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of
arbitration shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on
the award and/or for enforcement of the award.

12. Miscellaneous

12.1  This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to
the extent such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.

12.2  If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable
according to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that
achieves to the greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3  Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either
in relation to that default or any subsequent one.

End of document
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Overview of This Manual

Structure of This Manual

This user’s manual consists of the following chapters.

Chapter Title Description

1 Overview Gives an overview of the GateWT software.
Lists the PC requirements for running Gate-WT and
gives information about system configuration.

2 Operating Procedure Gives procedures for entering environment and data
logging interval settings, and how to monitor the
operational status of the software.

3 Detailed Description of  Provides a detailed description of the functions of
Functions GateWT. Lists error messages, their causes, and
their corrective actions.
Index An alphabetical index of the manual's contents.

Scope of This Manual
This manual does not explain the basic operations of your PC's operating system (OS).
For information regarding the basic operations of Windows, see the Windows user’s
manual.

Conventions Used in This Manual
¢ Units
K Denotes 1024. Example: 10 KB
M Denotes 1024K.  Example: 10 MB
G Denotes 1024M.  Example: 2 GB

e Boldface Type
Hardware and software controls that the user manipulates such as dialog boxes,

buttons, and menu commands are often set in boldface type.

e Subheadings
On pages in chapters 1 through 3 that describe operating procedures, the following

subheadings are used to distinguish the procedure from their explanations.

This subsection contains the operating procedure used to carry out
the function described in the current section. All procedures are

written with inexperienced users in mind; experienced users may
not need to carry out all the steps.

Note Calls attention to information that is important for proper operation
of the instrument.
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Chapter 1 Overview

1.1

Features

Overview of GateWT Functions

GateWT is a software program that acquires data from WT series instruments and
transfers it to DAQLOGGER or Remote Monitor. Using GateWT allows you to monitor
data on DAQLOGGER or Remote Monitor that is measured on WT series instruments.
Yokogawa’'s DAQLOGGER is a software program that allows users to open a connection
from their PC to various kinds of Yokogawa recorders (the mR, VR, DARWIN, DX, MV,
and CX) and perform data logging and monitoring.

Yokogawa’s Remote Monitor is a software program that enables monitoring of data
logged by recorders or data logging software.

Note
When connecting the GateWT and WT1600 and acquiring data, you must set the WT1600’s

measurement range to Fixed Range since data communication is not possible if it is set to Auto

Range.

* Runs as a Windows application.

e Compatible with the following instruments: WT110, WT110E, WT130, WT200, WT210,
WT230, WT1010, WT1030, WT2010, WT2030, WT1030M, WT1600, WT1800 and
WT500.

e Up to 16 units of the WT100, WT200, WT1000, WT2000, WT1600, WT1800 or WT500
can be linked.

* Measurement can be performed at intervals of up to 0.5 seconds*.

* However, DAQLOGGER'’s shortest interval is 1 second. Also, the maximum speed of 0.5
seconds may not be attainable depending on the amount of data being read, the response time
of the device, and the communication speed.
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1.2

System

System Overview

This software can connect with and download data from a WT series instrument having

the following characteristics.

However, the harmonic option is not supported.

« AWTI110, WT110E, WT200, or WT210 with RS-232 or GP-IB communication
functions installed

« AWT230 or WT130 with RS-232 or GP-IB communication functions installed

¢ AWT1010, WT1030, WT1030M, WT2010, or WT2030 with RS-232 or GP-IB
communication functions installed

« AWT1600 with RS-232, GP-IB, or Ethernet functionality.

* A WT1800 with GP-IB or Ethernet functionality.

* AWT500 with GP-IB or Ethernet functionality.

Required Operating Systems

Run DAQWORX under any of the following operating systems.

* Windows 2000 Professional SP4

*  Windows XP Home Edition SP3

* Windows XP Professional SP3 (excluding Windows XP Professional x64 Editions)

e Windows Vista Home Premium SP2 (excluding the 64-bit editions)

e Windows Vista Business SP2 (excluding the 64-bit editions)

e Windows 7 Home Premium, SP1 (32-bit and 64-bit editions)

e Windows 7 Professional, SP1 (32-bit and 64-bit editions)

The language displayed by the software under different language versions of the OS are
as follows.

OS Language Software Language
Japanese Japanese
Other English

Hardware Requirements

The following hardware are required to use GateWT.

e PC: A PC that runs one of the OS above, and that meets the
following CPU and memory requirements.
When Using Windows 2000 or Windows XP
Pentium 4, 1.6 GHz or faster Intel x64 or x86 processor;
512 MB or more of memory
When Using Windows Vista
Pentium 4, 3 GHz or faster Intel x64 or x86 processor; 2 GB or
more of memory
When Using Windows 7
32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86
processor; 2 GB or more of memory
64-bit edition: Intel x64 processor that is equivalent to Intel
Pentium 4, 3 GHz or faster; 2 GB or more of memory

* Free disk space: 200 MB or more
e Communication device: An Ethernet (when connecting to DAQLOGGER, Remote

Monitor, WT1600, WT1800 or WT500), RS-232, or GP-IB port
that is recognized by the operating system.

e CD-ROM drive: Used to install the software
e Peripheral devices: A mouse supported by the operating system
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1.2 System Overview

GP-IB port:

Monitor:

Required for GP-IB communications between the software and
a WT series instrument

Please use the PCI-GPIB or PCMCIA-GPIB by National
Instruments.

A video card that is recommended for the OS and a display
that is supported by the OS, has a resolution of 1024x768 or
higher, and that can show 65,536 colors (16-bit, high color) or
more.

IM WX1-03E

- H



1.2 System Overview

System Configuration

TCP/IP connection
Monitor server protocpl
Data transfer

Remote Monitor

Ethernet

It is recommended that you run GateWT and DAQLOGGER on separate PCs.

Software Configuration

[ catewT |
GateWT

DAQLOGGER

Writes to file ] )
Status information

- File read out -

Serial , GP-IB,
or Ethernet
communications

WT series
instrument

GateWT Configurator consists of two separate software functions. The role of each

function within the configurator is as follows:

e Environment Setting Functions
These functions allow the user to enter various settings required by the executable
function for communications with the WT series instrument, as well as those required
for data transfers to and from DAQLOGGER and Remote Monitor. The user can also
view the execution status.

e Executable Function
The software reads data from the WT series instruments at fixed intervals. It also acts
as a monitor server, transferring data to DAQLOGGER and Remote Monitor.

Ethernet

Ethernet

Remote Monitor

1-4 IM WX1-03E



Chapter 2 Operating Procedure

2.1 Running and Exiting Gate-WT

Running the Software

Procedure

1. From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX >
GateWT > GateWT.

The GateWT Configurator opens, displaying the user interface.

B GateDx-P Configurator =lolx|

File Communication Execute Wiew Help

I
Recorder Setting

i Moctel Meas Ch Math Ch Address

Ready

Note

* When you start GateWT, it is restored to the same status that was active during the previous
session.

» If the program is closed while a process or service is running, the license will be considered to be “in use.”
If the message, “Invalid license number. Please reinstall.” appears when restarting the program, it may
indicate that the user is attempting to run a Gate program in excess of the number of available licenses.

Starting GateWT in Acquisition Start Mode

Procedure

1. From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX >
GateWT > GateWT, then right-click GateWT and select Create Shortcut.

2. Right-click the shortcut icon and select Properties.

3. Choose the Shortcut tab, then add /START to the right of the path in the Target
box and click OK.

GateWT Properties ﬂll

General  Shortcut | Eompatibilityl

@ Gatew T
[P hig

Target type: Application

Target location: Gatetw'T

Target: IQW’D FehGatew TAGatew T ConfigE . exe /START

4. Choose the shortcut from the Windows Start menu. The connection status of the
previous session is restored, and acquisition begins.

Exiting the Software

Procedure

1. Choose File > Exit from the menu bar, or click the X button at the right end of the title bar.

GateWT closes.
IM WX1-03E 2-1
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2.2 Entering Environment Settings

The following settings can be entered using the configurator.

Serial Port Settings

Procedure

Drag to select the
desired items

WT assignments, communications settings, and login settings
Acquisition interval settings for each WT

Port number settings (for the monitor server) as needed

The settings can be saved.

1. Click the Serial Setting tab or choose View > Serial Setting from the menu bar.
The Serial Setting tab is displayed.

4 GateDX-P Configurator =0 x]
File Communication Execute View Help

H S| &% e |2

Setial Setting < >

Port Mo. Type Biaud Rate Parity Bit

Click to display a list

Copies the setting in the first item
of the selection to all of the items in the selection

Turns the selected items ON and OFF

2. Enter settings for each item.

Port number : ON (blue)/OFF (gray)
Baud rate : 4800, 9600, 19200
Data length : Fixed at 8

Parity : Fixed at NONE

Stop bit : Fixed at 1

2-2
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2.2 Entering Environment Settings

WT Settings

Procedure

1. Click the WT Setting tab or choose View > WT Setting from the menu bar.
The WT Setting tab is displayed.

!M GateWT Configurator ;lglll

File Communication Execute View Help

(== N

WT Setting < >
M. Maclel Channel Mum Comm Type Address
01 GRIB o1
02 o ed NONE + Click to display a list

03
04
i
i
o7
i

na

MOME

-+ Only the active COM ports
(specified in serial port settings)
are displayed

+ Click to display the Input
Address dialog box

2. Enter the communication method and address.

Communication type : Select the port to be used for the connection. Only
the numbered COM ports turned ON in the serial
setting tab are displayed.

For GP-I1B
Click a cell in the Address column to open the dialog box in the figure below.
Enter the GP-IB address.

Input Address - WT 01 x|

GPIB

om0z 03 04 05 06 07 08
03 0 C1 12 ©13 £ 14 15 16
CAF 18 19 © 20 & X © 22 230 M
025 26 27 28 29 30

Cancel |

For Ethernet (ETHER)
Click Address to display the following dialog box.
Enter the IP address or host name, user name (only WT1600), and password
(only WT1600).
ioput address - wr o1

Ether
IP Address

localhost

Uszer Mame |
Password I

For Serial Ports Set to COM1-COM9 (RS-232 Ports)
An address is not entered.

Address : Only needed if the communication type is GP-IB.
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2.2 Entering Environment Settings

Auto

matic Model Determination

3. Click Auto determination on the toolbar or choose Communication > Recorder

Model Determination from the menu bar.
H|%|$» D !|‘?|
Auto determination button

The following items are displayed.

Model : The specific WT models to be connected.
Channel : The number of channels on the WT to be connected.
54 GateWT Configurator I [ 3
File Communication Execute Wiew Help
== T S
WT Setting < >
Channel Mum Comm Type Address

o, hodel
01 0
0z
03
04
05
05
a7
s
09
10
1
12
13
14
13
16

Tag Settings

4. Double-click the tag number cell on the WT setting tab of the tag that you wish to set.

The Tag Setting dialog box opens.

Cannot be changed
(see chapter 3 regarding codes)

Initial settings of the tag names are
assigned from information obtained during
automatic model determination

Drag to select a
range of items

Tag Setting - WT01

Element1

Tag Mo. Ot Pt

Ld 1oz [SRY
| TAGOZ
| TAGOZ
[ad Tacos |
d-1ac05 (5B

| TAGOE

Choose the decimal place

Enter the upper and lower limit
values of span (-1E16~1E16)

Enter the units

Channel Mame

Tag Mame

Click to display the Color
setting dialog box

Test results
displayed here

x|

OK

Cancel | Test Execute Test Stap

Turns the selected items
ON and OFF

Copies the setting in the first
item of the selection to all of the
items in the selection

Restore the default
color to all tags

2-4
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2.2 Entering Environment Settings

Executing the Test
5. Click the Test Execution button in the Tag Setting dialog box.
The test result is displayed in the value column.
Stopping the Test
6. Click the Test Stop button.

Scan Interval and Retry Settings

Procedure

1. Click the Scan Interval Setting tab or choose View > Scan Interval Setting from
the menu bar.

The Scan Interval Setting tab is displayed.

!H GateWT Configurator ;Iglll

File Communication Execute View Help

H &% @ |2
Scan Interval Setting

Scan Intervalimsec)

4>

Retry

Intervallsec)

1000

Ready

Scan Interval Settings
2. Specify a scan interval from 0.5 to 3600 seconds.
Setting the Number of Retries
3. Turn the communication retry setting ON or OFF.
4. Enter the time interval between retries.
The available setting range is 30 to 3600 seconds.

Port Settings

Procedure

1. Choose File > Port Number from the menu bar.

PortSetting =

I anitor

ok | cewcer |

2. You can change the port number used by the monitor server.
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2.2 Entering Environment Settings

Saving Environment Settings

Procedure

Test Acquisition

Procedure

1 Click the Save button on the tool bar or choose File > Save from the menu bar.

IEAES- S0
|

Save button

1. Double-click a number in the GateWT Configurator.

The Tag Setting dialog box opens.

!H GateWT Configurator : ;Iglll

File Communication Execute View Help

(= s T S 74

WT Setting

4>

M. Maclel Channel Mum Comm Type Address
Double-click S g

Tag Setting - WT01

Tag M.

| TAGM
| TRGOZ
| TAGOS
| TRGDL
| TAGOS
| TRGOE
| TAGOT
| TAGOE
| TRGDI
| TAG10
[ TRG11
| TAG1Z
[ TRG1Z
| TAG14
| TRG1S
[ TRG1E
| Tac17
[ TaG18
| Tacia
[ Tac20

Ok Cancel | Test Execute | TESH G

Click Test acquisition result

2. Click the Test Execute button.

The test acquisition result is displayed in the Value column.

2-6
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2.3 Connecting from DAQLOGGER or Remote
Monitor

While the executable function is running, DAQLOGGER or Remote Monitor works via
Ethernet to log and monitor the data that the WT is acquiring. GateWT’s executable
function acts as the client of a DAQLOGGER or Remote Monitor that is running as the
monitor server.

In this case, system numbers are assigned as follows:
WT assigned to WTO01 : 0
WT assigned to WT02 : 1

Connecting from DAQLOGGER

Procedure

See section 2.6 of the WX101 DAQLOGGER WX81 DAQLOGGER Client Package
User’s Manual (IM WX101-01E).

Note

e If a connection is made with GateWT when DAQLOGGER'’s system server setting is set to
No system number, the connected WTs are handled on the same system. For example,
if a GateWT with two WTs connected is set to No system number on DAQLOGGER,
DAQLOGGER handles both units channels as a single connected GateWT.

e When recorder model determination is performed by DAQLOGGER, models numbered 01
under GateWT'’s “WT Setting” are displayed as No. 00. To identify models numbered 02 or
higher, specify the system number on DAQLOGGER. For example, for number 02, specify
01 under System No.

Connecting from Remote Monitor

Procedure

See section 8.1 of the WX101 DAQLOGGER WX81 DAQLOGGER Client Package
User’s Manual (IM WX101-01E), or section 9.2 of the WX102 DAQ32Plus WX82
DAQ32Plus Client Package User’s Manual (IM WX102-01E).
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2.4 Process Run/Stop and Service Run/Stop

Running/Stopping from the Menu Bar
Procedure

Running as a Process or Service
1. Click the Service execution or Process execution button on the tool bar. Or,
choose Execute > Service or Execute > Process from the menu bar.
The executable function starts as a process or service. “Service” or “Process” is
displayed under Practice Status on the Practice Status tab.
|H|m|$> S $|‘?|

Stop button
Process execution button

Service execution button

Note

* Service execution can only be specified by users with Administrator privileges.
e Services cannot be executed when using Windows Vista.

Stopping the Process or Service

1. Click the Stop button on the tool bar or choose Execute > Stop from the menu bar.
The Practice Status item shown on the Practice/Status tab displays “Stop.”

Running/Stopping the Executable Function from the Practice/Status Tab
Procedure

1. Click the Practice/Status tab or choose View > Practice/Status from the menu bar.
The Practice/Status tab is displayed.

54 GateWT Configurator o ] 5|
File Communication Execute View Help

H| S| &% @ !|?|

Scan Interval Setting T Port Setting T ExecutioniStatus I

—Practice —Status
Practice Status : Stop i
Type ——————— Select the practice type
' Process Cliert Connection Status
) Service
Start
Stop

Running as a Process or Service
2. Select to execute the function as a process or service.
3. Click Practice.

The executable function starts, and “Service” or “Process” is displayed under
Practice Status.

Stopping the Process or Service
2. Click the Stop button.
“Stop” is displayed for the practice status.
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2.5 Viewing the Status of the Executable Function

Procedure

Displaying the Connection Status

1. Click the Execution/Status tab, or choose View > Execution/Status from the
menu bar.

The Execution/Status tab is displayed, allowing you to see the method under
which the executable function may be running (as a process or as a service),
whether or not it is running, and with which PCs communications are open.

File Communication Execute  Views Help
FIGIEEE

Scan Interval Setting T Port Setting T ExecutionStatus m

[~ Practice -~ Status

Practice Status : Process

Ty

F! Frocess

[ Service,

- Displays the names
of connected clients

— Double-click to display the
Error Indicator dialog box

Ready

Select the Displays the communications status with the client
practice type Gray: Stopped
Red: Error

Green: Normal

Viewing Error Detalil

2. Double-click the box displaying the client communication status on the Execution/
Status tab (shown above).
The Error Indicator dialog box opens.

Error Indicator x|

o

See section 3.3 for error messages.
Note

If a warning message is displayed (code Wxxxx), the lamp that displays the connection
status by color does not blink red.

e When an error occurs and the lamp blinks red, the Error Indicator dialog box appears. If you
close the dialog box, the lamp turns green.

IM WX1-03E 2-9

alnpaosold Bunelado H



2.6 Viewing Version Information

Procedure

1. Click the About button on the tool bar or choose Help > About from the menu bar.

|H|@|$> ah !|‘?|
About button

The Version dialog box opens.

GatewsT Configurator | Version a4 I
1F .l ).

Copyright (C) 2003-2011 YOKOGAWA Electric Corporation

Software Japan
This Product is licensed to
Company name

User name
License number
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Chapter 3

Detailed Description of Functions

3.1

Overview

GateWT opens communications with WT series instruments and acquires data at

regular intervals. Through the monitor server function, the acquired data is transferred

to DAQLOGGER or Remote Monitor via Ethernet. GateWT Configurator consists of two
separate software functions. The following is a list of the features of each software function.

Environment Setting Functions
Basically, the environment setting functions are used to enter all environment settings
required to run the executable function. The environment setting functions include the

following :
Entry of parameters used for communications with up to 16 WTs.
For GP-IB : Address
For serial communications : Port, baud rate
For Ethernet : IP address or host name, user name, password

Display of information (model and number of channels) from the WTs to be connected
The software can open communication with the WTs and obtain this information automatically.
Tag settings for each WT

e Use/Do not use (ON/OFF)

e Upper/lower limit of span

e Decimal place

e Unit

e Tag name

e Color

Entry of the acquisition interval and port numbers for the executable function
Test execution

The above communication parameters, information from the WT, acquisition interval,
and port numbers can be saved

Later, this information can be loaded by the executable function.

Runs/stops the executable function as a process

Two executable functions cannot be run at the same time.

If the function is already running as a service, it cannot be run as a process.
Registers/deletes the executable function as a process

The function can run as a service while being registered.

It can be registered as an automatically executable service.

Displays the status of the executable function

Stopped, running as a service, running as a process

Displays a list of monitor clients connected with the executable function
Displays errors from the executable function

Sockets are used for communication with the executable function.

Executable Function
Features of the executable function are as follows:

Runs as a service

Multiple instances of the function may not be run simultaneously
Reads the settings file and connects with up to 16 WTs
Communication protocols: GP-IB, RS-232, Ethernet

Reads instantaneous data from the WTs at fixed intervals and saves the data to
internal memory

Reading interval: 0.5 — 3600 seconds

The internal memory holds the 1800 most recent data samples.
Runs as a monitor server

Compatible with the DAQLOGGER monitor server specifications.
Provides a list of clients connected to the status display function

IM WX1-03E
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3.2 Detailed Description of Functions

Serial Port

The communications ports available to GateWT are the COM1-COM9 serial (RS-232)
ports. The user must enter the following port settings.

e Use/Do not use (ON/OFF)

e Baudrate: Select 4800, 9600, or 19200

e Data length : Fixed at 8

e Parity : Fixed at NONE

e Stop bit : Fixed at 1

GP-IB Communication

GateWT can use GP-IB addresses 1-30.

Ethernet Communication

WT Settings

The WT1600, WT1800, and WT500 can perform Ethernet communications. Enter the IP
address or host name, user name (only WT1600), and password (only WT1600).

GateWT allows simultaneous connection with any combination of 16 of the following
instruments: WT110, WT110E, WT130, WT200, WT210, WT230, WT500, WT1010,
WT1030, WT1030M, WT1600, WT1800, WT2010, or WT2030.
The user must enter the following on the WTs to be accessed.
e Choose a communication method (COMx , GP-IB, or Ethernet)
For GP-IB
Communications mode : 488.2
Address : 1-30
For RS-232 (for instruments other than the WT1600)
Communications mode : 488.2
Handshaking : 0
Format : 0
Delimiter : Cr + Lf
Baud rate : 4800, 9600, 19200
For RS-232 (WT1600)
Communication mode : 488.2
Handshaking : CTS-RTS
Format : 8-NO-1
Delimiter : Cr+Lf
Baud rate : 4800, 9600, 19200
For Ethernet : Enter the following settings.
When Using DHCP
Domain name
Primary DNS server address
Secondary DNS server address
Primary domain suffix
Secondary domain suffix
When Using DNS
IP address
Subnet mask
Default gateway

Note
When connecting with DAQLOGGER to acquire data from the WT, if the number of channels
set on the WT Setting tab exceeds 1600, 1600 channels of data is sent to DAQLOGGER,
starting with the first channel of the instrument of the smallest system number. Also, if an error
occurs on an instrument during the first communication and communication is restored by
executing a communication retry, connection is possible with that instrument in 1 scan mode
without any channels being cut out.

3-2
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3.2 Detailed Description of Functions

Automatic Model Determination

Scan Interval

If you select a WT and perform automatic model determination, the model and number of
channels are passed to the WT Setting tab on the configurator.

However, harmonic option output for WT1600 and harmonic mode for WT1600 are not
supported.

Models and Number of Channels (Model Name in Brackets)

Model Number of channels

WT110 [253401] 19
WT110E [253451]

WT200 [253421]

WT210 [760401]

WT130 (2Elements) [253502] 53
WT230 (2Elements) [760502]

WT230 (3Elements) [253503] 70
WT230 (3Elements) [760503]

WT1010 [253610] 18
WT2010 [253101]

WT1030 (2Elements) [253620] 46
WT2030 (2Elements) [253102]

WT1030 (3Elements) [253630] 61
WT2030 (3Elements) [253103]

WT1030M [253640] 68
WT1600 (1Elements) [760101-01/-10] 76
WT1600 (1Elements) [760101-02/-11/-20] 123
WT1600 (1Elements) [760101-03/-12/-21/-30] 170
WT1600 (1Elements) [760101-04/-13/-22/-31/-40] 197
WT1600 (1Elements) [760101-05/-14/-23/-32/-41/-50] 224
WT1600 (1Elements) [760101-06/-15/-24/-33/-42/-51/-60] 251
WT1800 (1Elements) [WT1801-01/-10] 55
WT1800 (2Elements) [WT1802-02/-11/-20] 104
WT1800 (3Elements) [WT1803-03/-12/-21/-30] 104
WT1800 (4Elements) [WT1804-04/-13/-22/-31/-40] 179
WT1800 (5Elements) [WT1805-05/-14/-23/-32/-41/-50] 205
WT1800 (6Elements) [WT1806-06/-15/-24/-33/-42/-51/-60] 254
WT500[1Elements] (760201) 99
WT500[2Elements] (760202) 156
WT500[3Elements] (760203) 213

* The number of WT500 channels given above is with the /G5 and /DS options. If an option
is not installed, the number of channels is decreased by the number of channels related to
that option. The number of WT1800 channels given above is with the /G5 or /G6, /DT, /IMTR
or /AUX options. If an option is not installed, the number of channels is decreased by the
number of channels related to that option.

A scan interval from 0.5 to 3600 seconds is selected for each of the 16 WTs.

Note

When connecting to DAQLOGGER and acquiring data from the WTs, if GateWT’s scan interval
is longer than that of DAQLOGGER, DAQLOGGER logs the same data repeatedly until the
next GateWT scan interval. Therefore, it is recommended that GateWT's scan interval be set
to a value smaller than DAQLOGGER's scan interval.

Setting the Number of Retries

The Retry function can be turned ON and OFF for each of the 16 WTs.

If Retry is turned ON, a retry interval of 30 to 3600 seconds can be specified.
Communication is reattempted each time the specified number of seconds elapses.
Retries are also performed on instruments with which a communication error occurred
during the first communication.

IM WX1-03E

3-3

suonoun4 jo uondiosag pejrelag H



3.2 Detailed Description of Functions

Port Settings

GateWT uses the following ports.

* Monitor server port
The port used for communications from DAQLOGGER and Remote Monitor.

e Status acquisition port
The port from which the status display software acquires status from the executable
software. Search for an empty port to use as the status acquisition port.

Running/Stopping the Executable Function

The user interface allows you to start and stop the executable function.
The executable function runs under one of the following two methods or “types.”
e Process Run/Stop
The executable function is run/stopped as a process.
e Service Run/Stop
The executable function is registered as an automatically executing service, then
run. After an executable function running as a service is stopped, its registration as a
service is deleted.

Note

As indicated by the service execution status, the executable function continues processing

even when the user has logged off of Windows. Also, the software is automatically run as a
service when the computer is turned ON. Service execution can only be specified by users
with Administrator privileges. Services cannot be executed when using Windows Vista.

Monitor Server Function of the Executable Function

When the executable function is running, you can connect from DAQLOGGER or
Remote Monitor via Ethernet using the remote monitor protocol, and acquire data. In this
case, system numbers are assigned as follows:

WT assigned to WT01: O

WT assigned to WT02 : 1
If GateWT is connected without specifying a system number on DAQLOGGER, all WTs
are regarded as being of the same system. For example, if a GateWT connected to two
WTs is connected to DAQLOGGER without specifying a system number, it appears as
though a single GateWT with two WTs worth of channels is connected.

Executable Function Status Display

Test Acquisition

The status display shows the status of the environment setting and executable functions.
The information from the executable function that can be displayed is as follows:
« Practice status (stopped, running as a service, running as a process)
e Connection status from the client
Displays a list of PCs running DAQLOGGERS and Remote Monitors with which the
executable software has opened a connection.
e Error display
Shows the presence or absence of errors on the executable function.

You can perform a test acquisition on each tag using the configurator. During the test
acquisition, data is read from WT output channels assigned to each tag and displayed
as digital values. This allows you to determine whether the communication settings for
each tag are correct. The test acquisition gets values from assigned tags at intervals of
approximately 1 second. Up to 32 tags can be assigned to a group, and up to 4 groups
can be displayed.

The number of tags that can be assigned to a group differs depending on the type of
connected device, and only up to 4 groups can be displayed.
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3.2 Detailed Description of Functions

Group and Channel Assignments
If connected from the remote monitor, the initial group and channel assignments are as
follows, and cannot be changed.

Note

If connected to GateWT using DAQLOGGER, the group and waveform assignments are
ignored.

WT100, WT110E [17]

Group String Waveform Number  Channel Assignment

1 group Elementl W01 V
W02 A
W03 W
W04 VA
W05 VAR
W06 PF
W07 DEGR
W08 VHZ
W09 AHZ
W10 WH
W1l WHP
W12 WHM
W13 AH
w14 AHP
W15 AHM
W16 VPK
w17 APK
W18 MATH
W19 TIME

WT200, WT210 [19]

Group String Waveform Number  Channel Assignment

2 group Elementl W01 \%
W02 A
W03 W
W04 VA
W05 VAR
W06 PF
Wo7 DEGR
W08 VHZ
W09 AHZ
W10 WH
W11 WHP
W12 WHM
W13 AH
W14 AHP
W15 AHM
W16 VPK
W17 APK
W18 MATH
W19 TIME
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3.2 Detailed Description of Functions

WT130 (Three-phase, three-wire), WT230(Three-phase, three-wire) [53]

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W19 V—TIME (same as WT200)
2 group Element3 WO01—W17 V—APK
3 group Sigma W01—W17 V—APK

WT130 (Three-phase, four-wire), WT230(Three-phase, four-wire) [70]

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W19 V—TIME (same as WT200)
2 group Element2 WO01—W17 V—APK
3 group Element3 WO01—W17 V—APK
4 group Sigma W01—W17 V—APK

WT1010, WT2010 [18]

Group String

Waveform Number

Channel Assignment

1 group Elementl

W01 V
W02 A
W03 W
W04 VA
W05 VAR
W06 PF
W07 DEGR
W08 VPK
W09 APK
W10 WH
W11 WHP
W12 WHM
W13 AH
W14 AHP
W15 AHM
W16 FREQ
W17 MATH
W18 TIME

WT1030 (Three-phase, three-wire), WT2030(Three-phase, three-wire) [46]

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W18 V—TIME (same as WT1010)
2 group Element3 W01—W15 V—AHM
3 group Sigma W01—W15 V—AHM

WT1030(Three-phase, four-wire), WT2030(Three-phase, four-wire) [61]

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W18 V—TIME (same as WT1010)
2 group Element2 WO01—W15 V—AHM
3 group Element3 W01—W15 V—AHM
4 group Sigma W01—W15 V—AHM

WT1030M(Three-phase, four-wire)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W18 V—TIME (same as WT1010)
2 group Element2 W01—W15 V—AHM
3 group Element3 W01—W15 V—AHM
4 group Sigma W01—W15 V—AHM
5 group Motor W01 TORQ
W02 RPM
W03 SRPM
W04 SLIP
W05 MPOW
WO06 MEFF
W07 TEFF
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3.2 Detailed Description of Functions

WT1600(1Element model)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01 URMS
W02 UMN
W03 ubC
W04 UAC
W05 IRMS
W06 IMN
W07 IDC
W08 IAC
W09 P
W10 S
W11 Q
W12 LAMBda
W13 PHI
W14 FU
W15 FI
W16 PC
W17 UPPeak
W18 UMPeak
W19 IPPeak
W20 IMPeak
W21 TIME
W22 WH
W23 WHP
W24 WHM
W25 AH
W26 AHP
W27 AHM

2 group SigmaA W01l URMS
W02 UMN
W03 ubC
W04 UAC
W05 IRMS
WO06 IMN
W07 IDC
W08 IAC
W09 P
W10 S
W11 Q
W12 LAMBda
W13 PHI
w14 PC
W15 WH
W16 WHP
W17 WHM
W18 AH
W19 AHP
W20 AHM

(Cont. on next page.)
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3.2 Detailed Description of Functions

Group String

Waveform Number

Channel Assignment

3 group Other W01l ETA
W02 SETA
W03 F1
W04 F2
WO05 F3
WO06 F4
WO07 DURMS1
w08 DUMN1
W09 DUDC1
W10 DUAC1
W11 DURMS2
W12 DUMN2
W13 DUDC2
W14 DUAC2
W15 DURMS3
W16 DUMN3
W17 DUDC3
W18 DUAC3
W19 DURMS4
W20 DUMN4
W21 DUDC4
W22 DUAC4

4 group Motor w01 TORQue
W02 SPEed
W03 SYNC
W04 SLIP
WO05 PM
WO06 MEATa
wWo7 MBETa

WT1600(2Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W27 URMS—AHM
2 group Element2 W01—W27 URMS—AHM
3 group SigmaA W01—W20 URMS—AHM
4 group SigmaB W01—W?20 URMS—AHM
5 group Other W01—W22 ETA—DUAC4
6 group Motor WO01—WO07 TORQue—MBETa

WT1600(3Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W27 URMS—AHM
2 group Element2 WO01—W27 URMS—AHM
3 group Element3 WO01—W27 URMS—AHM
4 group SigmaA W01—W20 URMS—AHM
5 group SigmaB W01—W20 URMS—AHM
6 group SigmaC W01—W20 URMS—AHM
7 group Other W01—W22 ETA—DUAC4
8 group Motor W01—WO07 TORQue—MBETa
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3.2 Detailed Description of Functions

WT1600(4Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W27 URMS—AHM
2 group Element2 WO01—W27 URMS—AHM
3 group Element3 WO01—W27 URMS—AHM
4 group Element4 W01—W27 URMS—AHM
5 group SigmaA W01—W20 URMS—AHM
6 group SigmaB W01—W20 URMS—AHM
7 group SigmaC W01—W20 URMS—AHM
8 group Other W01—W22 ETA—DUAC4
9 group Motor WO01—WO07 TORQue—MBETa

WT1600(5Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W27 URMS—AHM
2 group Element2 WO01—W27 URMS—AHM
3 group Element3 WO01—W27 URMS—AHM
4 group Element4 W01—W27 URMS—AHM
5 group Element5 WO01—W27 URMS—AHM
6 group SigmaA W01—W20 URMS—AHM
7 group SigmaB W01—W?20 URMS—AHM
8 group SigmaC W01—W20 URMS—AHM
9 group Other WO01—W22 ETA—DUAC4
10 group Motor WO01—WO07 TORQue—MBETa

WT1600(6Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W27 URMS—AHM
2 group Element2 WO01—W27 URMS—AHM
3 group Element3 WO01—W27 URMS—AHM
4 group Element4 W01—W27 URMS—AHM
5 group Element5 WO01—W27 URMS—AHM
6 group Element6 W01—W27 URMS—AHM
7 group SigmaA W01—W20 URMS—AHM
8 group SigmaB WO01—W20 URMS—AHM
9 group SigmaC W01—W20 URMS—AHM
10 group Other W01—W22 ETA—DUAC4
11 group Motor WO01—WO07 TORQue—MBETa

IM WX1-03E
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3.2 Detailed Description of Functions

WT1800(1Element model)

Group String Waveform Number  Channel Assignment

1 group Elementl W01 URMS
W02 UMN
W03 ubDC
W04 IRMS
W05 IMN
W06 IDC
W07 P
W08 S
W09 Q
W10 LAMBDA
W11 PHI
w12 FU
W13 Fl
W14 TIME
W15 WH
W16 WHP
W17 WHM
W18 AH
W19 AHP
W20 AHM

2 group ElemHrm1 WO01 UK_1

(/G5, 1G6) W02 UK_T

W03 IK_1
W04 IK_T
W05 UTHD
W06 ITHD

3 group Other W01l ETAL
W02 ETA2
W03 ETA3
W04 ETA4
W05 F1
WO06 F2
WO07 F3
W08 F4
W09 F5
W10 F6
W11 F7
W12 F8
W13 F9
W14 F10
W15 F11
W16 F12
W17 F13
W18 F14
W19 F15
W20 F16
W21 F17
W22 F18
W23 F19
w24 F20

4 group Motor (/MTR) WO01 SPEED
W02 TORQUE
W03 SYNCSP
Wo4 SLIP
W05 PM

5 group Aux (/AUX) W01l AUX1
W02 AUX2
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3.2 Detailed Description of Functions

Note

» Since the maximum number of parameters that can be acquired via communications on the
WT1800 is 255, all functions cannot be acquired on GateWT. To acquire functions not in the
table, you can set them in the WT1800's user-defined functions (F1 to F20).

(/G5, /IG6) can be selected on instruments with the harmonic measurement functions option,

(/DT) can be selected on instruments with the delta computation functions option, (/MTR)
can be selected on instruments with the motor evaluation functions option and (/AUX) can

be selected on instruments with the auxiliary input measurement functions option. If an

instrument without an option is selected, the group numbers shift to fill in the missing option.

Elementl
Element2
ElemHrm1
ElemHrm2
SigmaA
Other

Aux

For example, groups are assigned as follows for a 2-element model with (/G5) and (/Aux)
but without (/DT), (/MTR).
Group 1:
Group 2:
Group 3:
Group 4:
Group 5:
Group 6:
Group 7:

WT1800(2Elements model)

Group String Waveform Number Channel Assignment

1 group Elementl WO01—W20 URMS—AHM
2 group Element2 W01—W20 URMS—AHM
3 group ElemHrm1 W01—WO06 UK_1—ITHD
4 group ElemHrm2 WO01—WO06 UK_1—ITHD
5 group SigmaA WO01 URMS

W02 UMN

W03 IRMS

W04 IMN

W05 P

W06 S

W07 LAMBDA

W08 PHI

W09 WH

W10 WHP

Wil WHM

W12 AH

W13 AHP

W14 AHM
6 group Other WO01—W24 ETA1—F20
7 group DeltaA (/DT) W01 DU1

W02 DU2

W03 DU3

W04 DUS

W05 DI

W06 DP1

W07 DP2

W08 DP3

W09 DPS
8 group Motor W01—WO05 SPEED—PM
9 group Aux WO01—W02

IM WX1-03E
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3.2 Detailed Description of Functions

WT1800(3Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W20 URMS—AHM
2 group Element2 WO01—W20 URMS—AHM
3 group Element3 W01—W20 URMS—AHM
4 group ElemHrm1 WO01—WO06 UK_1—ITHD
5 group ElemHrm2 W01—WO06 UK_1—ITHD
6 group ElemHrm3 W01—WO06 UK_1—ITHD
7 group SigmaA W01—W14 URMS—AHM
8 group Other W01—W24 ETA1—F20

9 group DeltaA WO01—WO09 DU1—DPS

10 group Motor WO01—WO05 SPEED—PM
11 group Aux W01—W02 AUX1—AUX2

WT1800(4Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01—W20 URMS—AHM
2 group Element2 W01—W20 URMS—AHM
3 group Element3 W01—W20 URMS—AHM
4 group Element4 W01—W?20 URMS—AHM
5 group ElemHrm1 W01—WO06 UK_1—ITHD
6 group ElemHrm2 WO01—WO06 UK_1—ITHD
7 group ElemHrm3 WO01—WO06 UK_1—ITHD
8 group ElemHrm4 W01—WO06 UK_1—ITHD
9 group SigmaA W01—W14 URMS—AHM
10 group SigmaB W01—W14 URMS—AHM
11 group Other W01—W24 ETA1—F20
12 group DeltaA W01—W09 DU1—DPS
13 group DeltaB W01—WO09 DU1—DPS
14 group Motor WO01—WO05 SPEED—PM
15 group Aux WO01—W02 AUX1—AUX2

WT1800(5Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W20 URMS—AHM
2 group Element2 W01—W20 URMS—AHM
3 group Element3 WO01—W20 URMS—AHM
4 group Element4 WO01—W20 URMS—AHM
5 group Element5 W01—W?20 URMS—AHM
6 group ElemHrm1 W01—WO06 UK_1—ITHD
7 group ElemHrm2 WO01—WO06 UK_1—ITHD
8 group ElemHrm3 WO01—WO06 UK_1—ITHD
9 group ElemHrm4 W01—WO06 UK_1—ITHD
10 group ElemHrm5 W01—WO06 UK_1—ITHD
11 group SigmaA W01—W14 URMS—AHM
12 group SigmaB W01—W14 URMS—AHM
13 group Other W01—W24 ETA1—F20

14 group DeltaA W01—W09 DU1—DPS

15 group DeltaB WO01—W09 DU1—DPS

16 group Motor WO01—WO05 SPEED—PM
17 group Aux W01—W02 AUX1—AUX2
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3.2 Detailed Description of Functions

WT1800(6Elements model)

Group String

Waveform Number

Channel Assignment

1 group Elementl WO01—W20 URMS—AHM
2 group Element2 WO01—W20 URMS—AHM
3 group Element3 W01—W20 URMS—AHM
4 group Element4 W01—W20 URMS—AHM
5 group Element5 W01—W20 URMS—AHM
6 group Element6 W01—W20 URMS—AHM
7 group ElemHrm1 W01—WO06 UK_1—ITHD
8 group ElemHrm2 W01—WO06 UK_1—ITHD
9 group ElemHrm3 WO01—WO06 UK_1—ITHD
10 group ElemHrm4 WO01—WO06 UK_1—ITHD
11 group ElemHrm5 WO01—WO06 UK_1—ITHD
12 group ElemHrm6 W01—WO06 UK_1—ITHD
13 group SigmaA W01—W14 URMS—AHM
14 group SigmaB W01—W14 URMS—AHM
15 group SigmaC W01—W14 URMS—AHM
16 group Other WO01—W24 ETA1—F20
17 group DeltaA W01—WO09 DU1—DPS
18 group DeltaB W01—W09 DU1—DPS
19 group DeltaC W01—WO09 DU1—DPS
20 group Motor W01—WO05 SPEED—PM
21 group Aux W01—W02 AUX1—AUX2

IM WX1-03E
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3.2 Detailed Description of Functions

WT500(1Element model)

Group String

Waveform Number

Channel Assignment

1 group Elementl W01 URMS
W02 UMN
W03 ubDC
W04 URMN
W05 UAC
W06 IRMS
W07 IMN
W08 IDC
W09 IRMN
W10 IAC
W11 P
W12 S
W13 Q
W14 LAMBda
W15 PHI
W16 FU
W17 FI
W18 UPPeak
W19 UMPeak
W20 IPPeak
W21 IMPeak
W22 CFU
W23 CFI
W24 TIME
W25 WH
W26 WHP
W27 WHM
W28 AH
W29 AHP
W30 AHM
W31 WS
W32 WQ

2 group ElemHrm1(G5) W01 UK_0
W02 UK 1
W03 UK_T
W04 IK_0
W05 IK_1
W06 IK_T
W07 PK_0
W08 PK_1
W09 PK_T
W10 SK_0
W11 SK_1
W12 SK_T
W13 QK_0
W14 QK 1
W15 QK_T
W16 LAMBDAO
W17 LAMBDA1
W18 LAMBDAT
W19 PHIK_1
W20 PHIK_T
W21 PHIUK3
W22 PHIIk3
W23 UTHD
W24 ITHD
W25 PTHD

(Cont. on next page.)
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3.2 Detailed Description of Functions

Group String

Waveform Number

Channel Assignment

3 group Sigma w01 URMS
W02 UMN
W03 ubDC
W04 URMN
WO05 UAC
WO06 IRMS
WQ07 IMN
W08 IDC
W09 IRMN
W10 IAC
W11 P
W12 S
w13 Q
W14 LAMBda
W15 PHI
W16 WH
W17 WHP
W18 WHM
W19 AH
W20 AHP
W21 AHM
W22 WS
W23 WQ

4 group Other W01 ETAL
W02 ETA2
W03 F1
W04 F2
WO05 F3
W06 F4
WQ07 F5
W08 F6
WO09 F7
W10 F8

5 group Delta W01 DELTA1

(DT) w02 DELTA2

WO03 DELTA3
W04 DELTA4

6 group Phase w01 P_U1U2

(G5) W02 P_U1U3
W03 P_U1I1
W04 P_U1I2
WO05 P_U1I3
Note

With the WT500, because the maximum number of parameters that can be acquired via
communications is 255, the following cannot be acquired with the GateWT: 2nd through 50th
orders of U/I/P/S/Q/LAMBda/PHI; 1st, 2nd, and 4th through 50th orders of PHIU/PHII; and
UHDF, IHDF, and PHDF.
(G5) can be selected on instruments with the harmonic option, and (DT) can be selected on
instruments with the delta option. If an instrument without an option is selected, the group
numbers shift to fill in the missing option. For example, groups are assigned as follows for a
1-element model with (G5) but without (DT).

Group 1:
Group 2:
Group 3:
Group 4:
Group 5:

Elementl
ElemHrm1
Sigma
Other
Phase

IM WX1-03E
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3.2 Detailed Description of Functions

WT500(2Elements model)

Group String Waveform Number  Channel Assignment
1 group Elementl WO01—W32 URMS—WQ
2 group Element2 WO01—W32 URMS—WQ
3 group ElemHrm1 W01—W25 UK_0—PTHD
4 group ElemHrm2 W01—W25 UK_0—PTHD
5 group Sigma W01—W23 URMS—WQ
6 group Other W01—W10 ETA1—F8
7 group Delta W01—W04 DELTA1—DELTA4
8 group Phase W01—WO05 P_UlU2—P_U1I3

WT500(3Elements model)

Group String Waveform Number ~ Channel Assignment
1 group Elementl W01—W32 URMS—WQ
2 group Element2 WO01—W32 URMS—WQ
3 group Element3 WO01—W32 URMS—WQ
4 group ElemHrm1 WO01—W25 UK_0—PTHD
5 group ElemHrm2 W01—W25 UK_0—PTHD
6 group ElemHrm3 WO01—W25 UK_0—PTHD
7 group Sigma W01—W23 URMS—WQ
8 group Other W01—W10 ETA1—F8
9 group Delta W01—W04 DELTA1—DELTA4
10 group Phase WO01—WO05 P_UlU2—P_U1I3
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3.2 Detailed Description of Functions

Tag Settings
Initial settings of the tags are assigned according to the model information obtained
during automatic model determination.

WT100/WT200
WT110 Group 1 Element1(V, A, W, VA, VAR, PF, DEGR,
WT110E (Group name: Element1) VHZ, AHZ, WH, WHP, WHM, AH, AHP,
WT200 AHM)+|V|ATH+T|ME
WT210
WT130(2Element) Group 1 Element1(V-APK)+MATH+TIME
WT230(2Element) (Group name: Element1)

Group 2 Element3(V-APK)

(Group name: Element3)

Group 3 Sigma(V-APK)

(Group name: Sigma)
WT130(3Element) Group 1 Element1(V-APK)+MATH+TIME
WT230(3Element) (Group name: Element1)

Group 2 Element2(V-APK)

(Group name: Element2)

Group 3 Element3(V-APK)

(Group name: Element3)

Group 4 Sigma(V-APK)

(Group name: Sigma)
WT1000/WT2000
WT1010 Group 1 Elementl (V, A, W, VA, PF, DEGR, VPK,
WT2010 (Group name: Element1) APK, WH, WHP, WHM, AH, AHP, AHM)+

FREQ+MATH+TIME

WT1030 Group 1 Element1(V-AHM)+FREQ+MATH+TIME
WT2030 (Group name: Element1)

Group 2 Element3(V-AHM)

(Group name: Element3)

Group 3 Sigma(V~AHM)

(Group name: Sigma)
WT1030(3Element) Group 1 Elementl(V-AHM)+FREQ+MATH+TIME
WT2030(3Element) (Group name: Element1)

Group 2 Element2(V-AHM)

(Group name: Element2)

Group 3 Sigma(V-AHM)

(Group name: Element3)

Group 4 Sigma(V—-AHM)

(Group name: Sigma)
WT1030M Group 1 Elementl(V-AHM)+FREQ+MATH+TIME

(Group name: Element1)

Group 2 Element2(V-AHM)

(Group name: Element2)

Group 3 Element3(V-AHM)

(Group name: Element3)

Group 4 Sigma(V-AHM)

(Group name: Sigma)

Group 5 TORQ, RPM, SRPM, SLIP, MPOW,

(Group name: Sigma) MEFF, TEFF
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3.2 Detailed Description of Functions

WT1600

Tags set to group ElementX are the same as those for Elementl. Tags set to group
SigmaX are the same as those for SigmaA.

Note

Since the maximum number of parameters that can be acquired via communications by the
WT1600 is 255, GateWT cannot acquire Cfu, Chi, FfU, Ffl, Z, Rs, Xs, Rp, or Xp.

WT1600 (1Element)

Groupe 1

(Groupe Name:Element1)

Element1(URMS, UMN, UDC, UAC, IRMS, IMN, IDC, IAC, P,
S, Q, LAMBda, PHI, FU, FI, PC, UPPeak, UMPeak, IPPeak,
IMPeak, TIME, WH, WHP, WHM, AH, AHP, AHM)

Groupe 2 SigmaA(URMS, UMN, UDC, UAC, IRMS, IMN, IDC, IAC, P, S, Q,

(SigmaA) LAMBda, PHI, PC, WH, WHP, WHM, AH, AHP, AHM)

Groupe 3 Other(ETA, SETA, F1, F2, F3, F4, DURMS1, DUMN1, DUDC1,

(Other) DUAC1, DURMS2, DUDC2, DUAC2, DUMN2, DURM3, DUMNS3,
DUDC3, DUAC3, DIRM, DIMN, DIDC, DIAC)

Groupe 4 Motor(TORQue, SPEed, SYNC, SLIP, PM, MAETa, MBETa)

(Motor)

WT1600 (2Elements)

Groupe 1 (Elementl)

Elementl(URMS—AHM)

Groupe 2 (Element2)

Element2(URMS—AHM)

Groupe 3 (SigmaA)

SigmaA(URMS—AHM)

Groupe 4 (SigmaB)

SigmaB(URMS—AHM)

Groupe 5 (Other)

Other(ETA—DIAC)

Groupe 6 (Motor)

Motor(TORQue—MBETa)

WT1600 (3Elements)

Groupe 1 (Elementl)

Elementl(URMS—AHM)

Groupe 2 (Element2)

Element2(URMS—AHM)

Groupe 3 (Element3)

Element3(URMS—AHM)

Groupe 4 (SigmaA)

SigmaA(URMS—AHM)

Groupe 5 (SigmaB)

SigmaB(URMS—AHM)

Groupe 6 (SigmaC)

SigmaC(URMS—AHM)

Groupe 7 (Other)

Other(ETA—DIAC)

Groupe 8 (Motor)

Motor(TORQue—MBETa)

WT1600 (4Elements)

Groupe 1 (Elementl)

Elementl(URMS—AHM)

Groupe 2 (Element2)

Element2(URMS—AHM)

Groupe 3 (Element3)

Element3(URMS—AHM)

Groupe 4 (Element4)

Element4(URMS—AHM)

Groupe 5 (SigmaA)

SigmaA(URMS—AHM)

Groupe 6 (SigmaB)

SigmaB(URMS—AHM)

Groupe 7 (SigmaC)

SigmaC(URMS—AHM)

Groupe 8 (Other)

Other(ETA—DIAC)

Groupe 9 (Motor)

Motor(TORQUA—MBETa)

WT1600 (5Elements)

Groupe 1 (Elementl)

Elementl(URMS—AHM)

Groupe 2 (Element2)

Element2(URMS—AHM)

Groupe 3 (Element3)

Element3(URMS—AHM)

Groupe 4 (Element4)

Element4(URMS—AHM)

Groupe 5 (Element5)

Element5(URMS—AHM)

Groupe 6 (SigmaA)

SigmaA(URMS—AHM)

Groupe 7 (SigmaB)

SigmaB(URMS—AHM)

Groupe 8 (SigmaC)

SigmaC(URMS—AHM)

Groupe 9 (Other)

Other(ETA—DIAC)

Groupe 10 (Motor)

Motor(TORQue—MBETa)

WT1600 (6Elements)

Groupe 1 (Elementl)

Elementl(URMS—AHM)

Groupe 2 (Element2)

Element2(URMS—AHM)

Groupe 3 (Element3)

Element3(URMS—AHM)

Groupe 4 (Element4)

Element4(URMS—AHM)

Groupe 5 (Element5)

Element5(URMS—AHM)

Groupe 6 (Element6)

Element6(URMS—AHM)

Groupe 7 (SigmaA)

SigmaA(URMS—AHM)

Groupe 8 (SigmaB)

SigmaB(URMS—AHM)

Groupe 9 (SigmaC)

SigmaC(URMS—AHM)

Groupe 10 (Other)

Other(ETA—DIAC)

Groupe 11 (Motor)

Motor(TORQue—MBETa)
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3.2 Detailed Description of Functions

WT1800

Tags set to group ElementX are the same as those for Elementl. Tags set to group
ElemHrmX are the same as those for ElemHrm1. Tags set to group SigmaX are the
same as those for SigmaA. Tags set to group DeltaX are the same as those for DeltaA.

WT1800 (1Element)

Groupe 1
(Groupe Name:Elementl)

Elementl (URMS, UMN, UDC, IRMS, IMN, IDC, P, S, Q,
LAMBDA, PHI, FU, FI, TIME, WH, WHP, WHM, AH, AHP, AHM)

Groupe 2 (ElemHrm1)

ElemHrm1 (UK_1, UK_T, IK_1, IK_T, UTHD, ITHD)

Groupe 3 (Other)

Other (ETAL, ETA2, [ETA3, ETA4, F1, F2, F3, F4, F5, F6, F7, F8,
F9, F10, F11, F12, F13, F14, F15, F16, F17, F18, F19, F20)

Groupe 4 (Motor)

Motor (SPEED, TORQUE, SYNCSP, SLIP, PM)

Groupe 5 (Aux)

Aux (AUX1, AUX2)

WT1800 (2Elements)

Groupe 1 (Elementl)

Elementl (URMS—AHM)

Groupe 2 (Element2)

Element2 (URMS—AHM)

Groupe 3 (ElemHrm1)

ElemHrm1 (UK_1—ITHD)

Groupe 4 (ElemHrm2)

ElemHrm2 (UK_1—ITHD)

Groupe 5 (SigmaA)

SigmaA (URMS, UMN, IRMS, IMN, P, S, LAMBDA, PHI, WH,
WHP, WHM, AH, AHP, AHM)

Groupe 6 (Other)

Other (ETA1—F20)

Groupe 7 (DeltaA)

DeltaA (DU1, DU2, DU3, DUS, DI, DP1, DP2, DP3, DPS)

Groupe 8 (Motor)

Motor (SPEED—PM)

Groupe 5 (Aux)

Aux (AUX1—AUX2)

WT1800 (3Elements)

Groupe 1 (Elementl)

Elementl (URMS—AHM)

Groupe 2 (Element2)

Element2 (URMS—AHM)

Groupe 3 (Element3)

Element3 (URMS—AHM)

Groupe 4 (ElemHrm1)

ElemHrm1 (UK_1—ITHD)

Groupe 5 (ElemHrm2)

ElemHrm2 (UK_1—ITHD)

Groupe 6 (ElemHrm3)

ElemHrm3 (UK_1—ITHD)

Groupe 7 (SigmaA)

SigmaA (URMS—AHM)

Groupe 8 (Other)

Other (ETA1—F20)

Groupe 9 (DeltaA)

DeltaA (DU1—DPS)

Groupe 10 (Motor)

Motor (SPEED—PM)

Groupe 11 (Aux)

Aux (AUX1—AUX2)

WT1800 (4Elements)

Groupe 1 (Elementl)

Elementl (URMS—AHM)

Groupe 2 (Element2)

Element2 (URMS—AHM)

Groupe 3 (Element3)

Element3 (URMS—AHM)

Groupe 4 (Element4)

Element4 (URMS—AHM)

Groupe 5 (ElemHrm1)

ElemHrm1 (UK_1—ITHD)

Groupe 6 (ElemHrm2)

ElemHrm2 (UK_1—ITHD)

Groupe 7 (ElemHrm3)

ElemHrm3 (UK_1—ITHD)

Groupe 8 (ElemHrm4)

ElemHrm4 (UK_1—ITHD)

Groupe 9 (SigmaA)

SigmaA (URMS—AHM)

Groupe 10 (SigmaB)

SigmaB (URMS—AHM)

Groupe 11 (Other)

Other (ETA1—F20)

Groupe 12 (DeltaA)

DeltaA (DU1—DPS)

Groupe 13 (DeltaB)

DeltaB (DU1—DPS)

Groupe 14 (Motor)

Motor (SPEED—PM)

Groupe 15 (Aux)

Aux (AUX1—AUX2)

(Cont. on next page.)
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3.2 Detailed Description of Functions

WT1800 (5Elements)

Groupe 1 (Elementl)

Elementl (URMS—AHM)

Groupe 2 (Element2)

Element2 (URMS—AHM)

Groupe 3 (Element3)

Element3 (URMS—AHM)

Groupe 4 (Element4)

Element4 (URMS—AHM)

Groupe 5 (Element5)

Element5 (URMS—AHM)

Groupe 6 (ElemHrm1)

ElemHrm1 (UK_1—ITHD)

Groupe 7 (ElemHrm2)

ElemHrm2 (UK_1—ITHD)

Groupe 8 (ElemHrm3)

ElemHrm3 (UK_1—ITHD)

Groupe 9 (ElemHrm4)

ElemHrm4 (UK_1—ITHD)

Groupe 10 (ElemHrm5)

ElemHrm5 (UK_1—ITHD)

Groupe 11 (SigmaA)

SigmaA (URMS—AHM)

Groupe 12 (SigmaB)

SigmaB (URMS—AHM)

Groupe 13 (Other)

Other (ETA1—F20)

Groupe 14 (DeltaA)

DeltaA (DU1—DPS)

Groupe 15 (DeltaB)

DeltaB (DU1—DPS)

Groupe 16 (Motor)

Motor (SPEED—PM)

Groupe 17 (Aux)

Aux (AUX1—AUX2)

WT1800 (6Elements)

Groupe 1 (Elementl)

Elementl (URMS—AHM)

Groupe 2 (Element2)

Element2 (URMS—AHM)

Groupe 3 (Element3)

Element3 (URMS—AHM)

Groupe 4 (Element4)

Element4 (URMS—AHM)

Groupe 5 (Element5)

Element5 (URMS—AHM)

Groupe 6 (Element6)

Element6 (URMS—AHM)

Groupe 7 (ElemHrm1)

ElemHrm1 (UK_1—ITHD)

Groupe 8 (ElemHrm2)

ElemHrm2 (UK_1—ITHD)

Groupe 9 (ElemHrm3)

ElemHrm3 (UK_1—ITHD)

Groupe 10 (ElemHrm4)

ElemHrm4 (UK_1—ITHD)

Groupe 11 (ElemHrm5)

ElemHrm5 (UK_1—ITHD)

Groupe 12 (ElemHrm6)

ElemHrm6 (UK_1—ITHD)

Groupe 13 (SigmaA)

SigmaA (URMS—AHM)

Groupe 14 (SigmaB)

SigmaB (URMS—AHM)

Groupe 15 (SigmaC)

SigmaC (URMS—AHM)

Groupe 16 (Other)

Other (ETA1—F20)

Groupe 17 (DeltaA)

DeltaA (DU1—DPS)

Groupe 18 (DeltaB)

DeltaB (DU1—DPS)

Groupe 19 (DeltaC)

DeltaC (DU1—DPS)

Groupe 20 (Motor)

Motor (SPEED—PM)

Groupe 21 (Aux)

Aux (AUX1—AUX2)
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3.2 Detailed Description of Functions

WT500

Tags set to group ElementX are the same as those for Element1.

Note

* With the WT500, because the maximum number of parameters that can be acquired via
communications is 255, the following cannot be acquired with the GateWT: 2nd through 50th
orders of U/I/P/SIQ/LAMBda/PHI; 1st, 2nd, and 4th through 50th orders of PHIU/PHII; and
UHDF, IHDF, and PHDF.

* (G5) can be selected on instruments with the harmonic option, and (DT) can be selected on
instruments with the delta option. If an instrument without an option is selected, the group
numbers shift to fill in the missing option. For example, groups are assigned as follows for a
1-element model with (G5) but without (DT).

Group 1:
Group 2:
Group 3:
Group 4:
Group 5:

Elementl
ElemHrm1
Sigma
Other
Phase

WT500 (1Element)

Group 1
(Group name:Element1)

Element1(URMS, UMN, UDC, URMN, UAC, IRMS, IMN, IDC, IRMN,
IAC, P, S, Q, LAMBda, PHI, FU, FI, UPPeak, UMPeak, IPPeak,
IMPeak, CFU, CFl, TIME, WH, WHP, WHM, AH, AHP, AHM, WS, WQ)

Group 2 Element1(UK_0, UK_1, UK_T, IK_0, IK_1, IK_T, PK_0, PK_1,
(ElemHrm1) PK_T, SK_0, SK_1, SK_T, QK_0, QK_1, QK_T, LAMBDO, LAMBD1,
(G5) LAMBDT, PHIK_1, PHIK_T, PHIUK3, PHIIk3, UTHD, ITHD, PTHD)
Group 3 SigmaA(URMS, UMN, UDC, URMN, UAC, IRMS, IMN, IDC, IRMN,
(Sigma) IAC, P, S, Q, LAMBda, PHI, WH, WHP, WHM, AH, AHP, AHM, WS, WQ)
Group 4 Other(ETAL, ETA2, F1, F2, F3, F4, F5, F6, F7, F8)

(Other)

Group 5 Delta(DELTAL, DELTA2, DELTAS3, DELTA4)

(Delta)

(bT)

Group 6 Phase(P_U1U2, P_U1U3, P_U1I1, P_U1I2, P_U1I3)

(Phase)

(G5)

WT500 (2Elements)

Group 1 (Element1)

Elementl(URMS—WQ)

Group 2 (Element2)

Element2(URMS—WQ)

Group 3 (ElemHrm1)
(G5)

Element1(UK_0—PTHD)

Group 4 (ElemHrm2)
(G5)

Element2(UK_0—PTHD)

Group 5 (Sigma)

Sigma(URMS—WQ)

Group 6 (Other)

Other(ETA—F8)

Group 7 (Delta)
(bT)

Delta(DELTA1—DELTA4)

Group 8 (Phase)
(G5)

Phase(P_U1U2—P_U1I3)

WT500 (3Elements)

Group 1 (Element1)

Elementl(URMS—WQ)

Group 2 (Element2)

Element2(URMS—WQ)

Group 3 (Element3)

Element3(URMS—WQ)

Group 4 (ElemHrm1)
(G5)

Element1(UK_0—PTHD)

Group 5 (ElemHrm2)
(G5)

Element2(UK_0—PTHD)

Group 6 (ElemHrm3)
(G5)

Element3(UK_0—PTHD)

Group 7 ( Sigma)

Sigma(URMS—WQ)

Group 8 (Other)

Other(ETA—F8)

Group 9 (Delta)
(bT)

Delta (DELTA1—DELTA4)

Group 10 (Phase)
(G5)

Phase (P_U1U2—P_U1I3)
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3.2 Detailed Description of Functions

A list of function names used in this manual and function names used on
the WT1600 (Numerical display header name)

Function names used
in this manual

: Function names used on the
WT21600 (Numerical display

header name)

Function names used
in this manual

: Function names used on the

WT1600 (Numerical display
header name)

URMS : Urms PC : Pc
UMN : Umean TIME : |-Time
UDC : Udc WH : Wp
UAC : Uac WHP : Wp+
IRMS :Irms WHM : Wp-

IMN  : Imean AH :q
IDC :ldc AHP : g+
IAC :lac AHM : g-
P P ETA :n
S S SETA : 1/n
Q :Q F1 :F1
LAMBda : A F2 :F2
PHI o F3 :F3
FU : Frequ (fU) F4 :F4
FlI : Freql (fl) DURMS : AUrms
UPPeak : U+peak (U+pk) DUMN : AUmean
UMPeak : U-peak (U-pk) DUDC : AUdc
IPPeak : I+peak (I+pk) DUAC : AUac
IMPeak : I-peak (I-pk) DIRMS : Alrms
CFU : CfU DIMN : Almean
CFI : Cfl DIDC : Aldc
FFU : FfU DIAC : Alac
FFI  : Ffl SPEed : Speed
zZ Z TORQue : Torque
RS :Rs SYNC : SyncSpd
XS :Xs SLIP : Slip
RP :Rp PM : Pm
XP  : Xp MAETa : nmA
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3.2 Detailed Description of Functions

A list of function names used in this manual and function names used on
the WT1800 (Numerical display header name)

Function names used : Function names used on the Function names used : Function names used on the
in this manual ~ WT1800 (Numerical display in this manual  WT1800 (Numerical display
header name) header name)
URMS : Urms F4 :F4
UMN :Umn F5 ' F5
UDC : Udc F6 : F6
IRMS :Irms F7 : F7
IMN @ Imn F8 : F8
IDC :ldc F9 :F9
P :P F10 : F10
S :S F11 :F11
Q :Q F12 :F12
LAMBDA : A F13 :F13
PHI :¢ F14 :Fl14
FU : fU (Frequ) F15 : F15
Fl :fl (Freql) F16 : F16
TIME : Time F17 : F17
WH WP F18 : F18
WHP : Wp+ F19 : F19
WHM : Wp- F20 : F20
AH :q DU1 : AU1
AHP g+ DU2 : AU2
AHM Q- DU3 : AU3
UK 1 :U(1) DUS : AUX
UK_T : U(Total) DI : Al
IK 1 :1(1) DP1 : AP1
IK_T : I(Total) DP2 : AP2
UTHD : Uthd DP3 : AP3
ITHD : Ithd DPS : APX
ETA1 :n1 TORQUE : Torque
ETA2 :n2 SPEED : Speed
ETA3 :n3 SYNCSP : Syncsp
ETA4 :n4 SLIP : Slip
F1 :F1 PM : Pm
F2 :F2 AUX1 : Auxl
F3 :F3 AUX2 : Aux2
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3.2 Detailed Description of Functions

A list of function names used in this manual and function names used on

the WT500 (Numerical display header name)

Function names used in : Function names used on Function names used in
this manual  the WT500 (Numerical this manual
display header name)

. Function names used on
the WT500 (Numerical
display header name)

URMS : Urms ETA1 : n1
UMN : Umn ETA2 : n2
UDC : Udc F1 : F1

URMN : Urmn F2 : F2
UAC : Uac F3 : F3
IRMS : Irms F4 : F4
IMN  : Imn F5 : F5
IDC : Idc F6 : F6
IRMN : Irmn F7 . F7
IAC  : lac F8 : F8

P P DELTAL : AF1
S : S DELTA2 : AF2
Q : Q DELTA3 : AF3
LAMBda : A DELTA4 : AF4
PHI o P_U1U2 : oUi-Uj
FU : FrequU(fU) P_U1U3 : o@Ui-Uk
FI - Freql(fl) P_U1lI1l : oUi-li
UPPeak : U-+peak(U+pk) P_U112 : oUi-lj
UMPeak : U-peak(U-pk) P_ULI3 : oUi-lk
IPPeak : I+peak(l+pk)
IMPeak : I-peak(l-pk)
CFU : CfU
CFl : Cfl

TIME : Time
WH : WP
WHP : WP+
WHM  :© WP—

AH : q

AHP : g+
AHM : g-
WS : WS
wWQ : WQ

UK_0 : U(k) k=0
UK_1 : U(k) k=1
UK. T : U(k) k=Total
IK 0 : I(k) k=0
IK.1  : I(k) k=1
IK_T : I(k) k=Total
PK_0 : P(k) k=0
PK_1 : P(k) k=1
PK_T : P(k) k=Total
SK_ 0 : S(k) k=0
SK 1 : S(k) k=1
SK_T : S(k) k=Total
QK_0 : Q(k) k=0
QK 1 : Q(k) k=1
QK_T : Q(k) k=Total

LAMBDO : A(k) k=0
LAMBD1 : A(k) k=1
LAMBDT : A(k) k=Total

PHIK_1 : o(k) k=1

PHIK_T : (k) k=Total

PHIUK3 : @U(k) k=3
PHIIk3 : ol(k) k=3
UTHD : Uthd
ITHD : Ithd
PTHD : Pthd
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3.2 Detailed Description of Functions

Channel Names, Tag IDs, and Tag Names
GateWT’s default channel names and tag IDs are the same: EL:V, ElA, ... etc.
The tag names are the names of the output items on the connected WT: TAG01, TAGO02,
...etc. These can be changed.

Note

When connecting DAQLOGGER to GateWT, channel names and tag IDs are ignored. You can
download tag names using tag setting software.

Channel Colors
The default channel colors on GateWT are the following 16 colors.

Red, Green, Blue, Magenta, Orange, Cyan, Brown, LightGray, Purple, Pink, Yellow,
White, CaditBlue, LightPink, LightGreen, Salmon
These can be changed.
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3.2 Detailed Description of Functions

GateWT is started and the data of a possible data collection from WT1600
GateWT doesn't correspond to “Harmonic component mode.” Therefore, the data
collection of the parameter in the harmonic component mode is not made.

Element Element Element Element Element Element A >B >C motor
1 2 3 4 5 6

Voltage RMS URMS URMS URMS URMS URMS URMS URMS URMS URMS TORQue

Voltage MEAN UMN UMN UMN UMN UMN UMN UMN UMN UMN  SPEed
Revolution
sped

Voltage DC ubcC ubcC ubcC ubcC ubC ubcC ubC UDC UDC SYNC
Synchronization
speed

Voltage AC UAC UAC UAC UAC UAC UAC UAC UAC UAC SLIP

Current RMS IRMS IRMS IRMS [IRMS IRMS IRMS [IRMS IRMS [IRMS PM
Motor output

Current MEAN IMN IMN IMN IMN IMN IMN IMN IMN IMN MAETa
Motor efficiency

Current DC IDC IDC IDC IDC IDC IDC IDC IDC IDC MBETa
total efficiency

Current AC IAC IAC IAC IAC IAC IAC IAC IAC IAC

Active power P P P P P P P P P

Apparent power S S S S S S S S S

Reactive power Q Q Q Q Q Q Q Q Q

Power factor LAMBda LAMBda LAMBda LAMBda LAMBda LAMBda LAMBda LAMBda LAMBda

Phase difference PHI PHI PHI PHI PHI PHI PHI PHI PHI

Voltage frequency FU FU FU FU FU FU

Current frequency Fl Fl Fl Fl Fl Fl

Corrected Power Pc PC PC PC PC PC PC PC PC PC

Voltage + peak UPPeak UPPeak UPPeak UPPeak UPPeak UPPeak

Voltage — peak UMPeak UMPeak UMPeak UMPeak UMPeak UMPeak

Current + peak IPPeak IPPeak IPPeak IPPeak IPPeak IPPeak

Current — peak IMPeak IMPeak IMPeak IMPeak IMPeak IMPeak

Integration time TI TI TI TI TI TI

Watt hour WH WH WH WH WH WH WH WH WH

(positive and negative)

Waitt hour (positive) WHP WHP WHP WHP WHP WHP WHP  WHP  WHP

Watt hour (negative) WHM WHM WHM WHM WHM WHM WHM WHM WHM

Current hour AH AH AH AH AH AH AH AH AH

(positive and negative)

Current hour (positive) ~ AHP AHP AHP AHP AHP AHP AHP  AHP  AHP

Current hour (negative) AHM AHM AHM AHM AHM AHM AHM  AHM  AHM
DURM DURM DURM

Delta computation DUMN DUMN DUMN

voltage MEAN

Delta computation DUDC DuUDC DuUDC

voltage DC

Delta computation DUAC DUAC DUAC

current AC

Delta computation DIRMS

current AC IRMS

Delta computation DIMN

current AC IMN

Delta computation DIDC

current AC IDC

Delta computation DIAC

current AC IAC

Efficiency 1 ETA

Efficiency 2 SETA

User-defined function 1 F1

User-defined function 2 F2

User-defined function 3 F3

User-defined function 4 F4
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3.2 Detailed Description of Functions

GateWT is started and the data of a possible data collection from WT1800

Element Element Element Element Element Element FA B >C motor
1 2 3 4 5 6

Voltage RMS URMS URMS URMS URMS URMS URMS URMS URMS URMS SPEED
Revolution
speed

Voltage MEAN UMN UMN UMN UMN UMN UMN UMN UMN UMN  TORQUE

Voltage DC ubC ubC ubC ubcC ubcC ubC SYNCSP
Synchronization
speed

Current RMS IRMS IRMS IRMS IRMS IRMS IRMS IRMS IRMS [IRMS SLIP

Current MEAN IMN IMN IMN IMN IMN IMN IMN IMN IMN PM
Motor output

Current DC IDC IDC IDC IDC IDC IDC

Active power P P P P P P P P P

Apparent power S S S S S S S S S

Reactive power Q Q Q Q Q Q

Power factor LAMBDA LAMBDA LAMBDA LAMBDA LAMBDA LAMBDA LAMBDA LAMBDA LAMBDA

Phase difference PHI PHI PHI PHI PHI PHI PHI PHI PHI

Voltage frequency FU FU FU FU FU FU

Current frequency Fl Fl Fl Fl Fl Fl

Integration time TIME TIME TIME TIME TIME TIME

Watt hour WH WH WH WH WH WH WH WH WH

(positive and negative)

Waitt hour (positive) WHP WHP WHP WHP WHP WHP WHP WHP WHP

Watt hour (negative) WHM WHM WHM WHM WHM WHM WHM WHM  WHM

Current hour AH AH AH AH AH AH AH AH AH

(positive and negative)

Current hour (positive) AHP AHP AHP AHP AHP AHP AHP AHP AHP
Current hour (negative) AHM AHM AHM AHM AHM AHM AHM AHM AHM
Rms voltage value of UK 1 UK1 UK1 UK1 UK1 UK1

harmonic order 1

Total harmonic voltage UK. T UK. T UK T UKT UKT UKT

Rms current value of IK_1 IK_1 IK_1 IK_1 IK_1 IK_1

harmonic order 1

Total harmonic current IK_T IK_T IK_T IK_T IK. T IK_T

Total harmonic voltage UTHD UTHD UTHD UTHD UTHD UTHD

distortion

Total harmonic current ITHD ITHD  ITHD ITHD ITHD ITHD

distortion

Equation for efficiency 1 ETAL
Equation for efficiency 2 ETA2
Equation for efficiency 3 ETA3
Equation for efficiency 4 ETA4
User-defined function 1  F1
User-defined function 2~ F2
User-defined function 3 F3
User-defined function 4  F4
User-defined function5  F5
User-defined function 6  F6
User-defined function 7 F7
User-defined function 8  F8
User-defined function 9 F9
User-defined function 10 F10
User-defined function 11  F11
User-defined function 12 F12
User-defined function 13 F13
User-defined function 14 F14

(Cont. on next page.)
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3.2 Detailed Description of Functions

User-defined function 15 F15
User-defined function 16 F16
User-defined function 17 F17
User-defined function 18 F18
User-defined function 19 F19
User-defined function 20 F20

Delta computation DU1
voltage 1

Delta computation DU2
voltage 2

Delta computation DU3
voltage 3

Delta computation DUS
voltage sigma

Delta computation DI
current

Delta computation DP1
power 1

Delta computation DP2
power 2

Delta computation DP3
power 3

Delta computation DPS
power sigma

Auxl AUX1
Aux2 AUX2
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3.2 Detailed Description of Functions

GateWT is started and the data of a possible data collection from WT500

Elementl Element2 Element3 z
Voltage RMS URMS URMS URMS URMS
Voltage MEAN UMN UMN UMN UMN
Voltage DC ubC ubC ubC ubDC
Voltage RMEAN URMN URMN URMN URMN
Voltage AC UAC UAC UAC UAC
Current RMS IRMS IRMS IRMS IRMS
Current MEAN IMN IMN IMN IMN
Current DC IDC IDC IDC IDC
Current RMEAN IRMN IRMN IRMN IRMN
Current AC IAC IAC IAC IAC
Active power P p P p
Apparent power S S S S
Reactive power Q Q Q Q
Power factor LAMBda LAMBda LAMBda LAMBda
Phase difference PHI PHI PHI PHI
Voltage frequency FU FU FU
Current frequency Fl Fl Fl
Voltage + peak UPPeak UPPeak UPPeak
Voltage — peak UMPeak UMPeak UMPeak
Current + peak IPPeak IPPeak IPPeak
Current — peak IMPeak IMPeak IMPeak
Voltage crest factor CFU CFU CFU
Current crest factor CFI CFI CFI
Integration time TIME TIME TIME
Watt hour (positive and negative) WH WH WH WH
Watt hour (positive) WHP WHP WHP WHP
Watt hour (negative) WHM WHM WHM WHM
Current hour (positive and negative) AH AH AH AH
Current hour (positive) AHP AHP AHP AHP
Current hour (negative) AHM AHM AHM AHM
Volt-ampare hours WS WS WS WS
Var hours WQ WQ WQ WwWQ
Rms voltage value of harmonic order O UK_0 UK_0 UK_0
Rms voltage value of harmonic order 1 UK 1 UK_1 UK_1
Total harmonic voltage UK T UK T UK T
Rms current value of harmonic order 0 IK_0 IK_0 IK_0
Rms current value of harmonic order 1 IK_1 IK_1 IK_1
Total harmonic current IK_T IK_T IK T
Active power of harmonic order 0 PK_0 PK_0 PK_0
Active power of harmonic order 1 PK_1 PK_1 PK_1
Total harmonic active power PK_T PK_T PK_T
Apparent power of harmonic order O SK_0 SK_0 SK_0
Apparent power of harmonic order 1 SK_1 SK_1 SK_1
Total harmonic apparent power SK_ T SK_T SK_T
Reactive power of harmonic order 0 QK 0 QK 0 QK 0
Reactive power of harmonic order 1 QK_1 QK 1 QK 1
Total harmonic reactive power QK_T QK_T QK_T
Power factor of harmonic order O LAMBDO LAMBDO LAMBDO
Power factor of harmonic order 1 LAMBD1 LAMBD1 LAMBD1
Total harmonic power factor LAMBDT LAMBDT LAMBDT
Phase difference of harmonic order 1 PHIK_1 PHIK_1 PHIK_1
Total harmonic phase difference PHIK_T PHIK_T PHIK_T
Phase difference between fundamental PHIUK3 PHIUK3 PHIUK3
signal voltage and harmonic order 3
Phase difference between fundamental PHIIk3 PHIIk3 PHIIk3
signal current and harmonic order 3
Total harmonic voltage distortion UTHD UTHD UTHD
Total harmonic current distortion ITHD ITHD ITHD
Total harmonic active power distortion PTHD PTHD PTHD

(Cont. on next page.)
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3.2 Detailed Description of Functions

Elementl Element2 Element3 b2
Equation for efficiency 1 ETAL
Equation for efficiency 2 ETA2
User-defined function 1 F1
User-defined function 2 F2
User-defined function 3 F3
User-defined function 4 F4
User-defined function 5 F5
User-defined function 6 F6
User-defined function 7 F7
User-defined function 8 F8
Delta computation 1 DELTA1
Delta computation 2 DELTA2
Delta computation 3 DELTA3
Delta computation 4 DELTA4
Phase difference UIU2 P_U1U2
Phase difference UIU3 P_U1U3
Phase difference UlI1 P U1l
Phase difference UlI2 P_U1I2
Phase difference UII3 P_U1I3
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3.3

Error Messages and Corrective Actions

Error

No. Message Corrective Actions

E211 Cannot write to file. Check if the disk capacity is sufficient or if the file systems is
normal.

E212 Cannot read file. Check if the file exists and is supported by the software or if the
file system is normal.

E213 Cannot open file. Check if the file exists and is supported by the software or if the
file system is normal

E401 Communication error. Check if the recorder connected for communication is powered on
and if the cable is properly connected. Also check the following
items according the the communication type.

* For Ethernet

Check if address settings are correct; the TCP/IP protocol is
installed in Windows; the Ethernet card is properly installed.

¢ For RS-232 and RS-422-A

Check if the baud rate settings match; the port (COM1 to COM9)
settings match, the address settings are correct (RS-422-A); the
serial port of the PC is active and the appropriate cable is being
used.

E402 Communication timeout. -

E403 Cannot open a communication port. Same as E401.

E501 Invalid license number. Install the software again.

Please reinstall the software.

E1010 Execution of aprocess failed. Check whether an executable function exists, or whether its
files are damaged. If this error appears frequently, reinstall the
software.

E1011 Execuition of a service failed. Check whether an executable function exists, or whether its
files are damaged. If this error appears frequently, reinstall the
software.

E1600 The WT1000/WT2000 does not support With WT1000/WT2000 series instruments, model determination
can

Message

No. Message

M1201 Model determination was successful.

M1210 Setting changes saved before execution.

Executable Function Messages

No. Message Corrective Actions

W[631] Data Lack Reduce the number of acquired data points or connected
instruments, or lengthen the scan interval.

E[673] Cannot open communication Same as E401.

E[674] Communication error Same as E401.

E[675] Communication time out Same as E401.

E[850] Command Error An error was received from the WT. Check the status of the WT.

E[851] Cannot setting WT Check whether the communication status and connected
instruments matches those specified in the software. If they do
not, perform model determination again.

E[852] Recive Continued Check the communication status.

E[853] Recieve data error Check the communication status.

1[606] Recovery Communication Connection recovered.
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